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I i Print

This printer supports Exif 2.2 (also called “ Exif Print”).

Exif Print is a standard for enhancing the communication between digital cameras and printers. By
connecting to an Exif Print-compliant digital camera, the camera’simage data at the time of shooting is
used and optimized, yielding extremely high quality prints.

I Canadian Radio Interference Regulations
Thisdigital apparatus does not exceed the Class B limits for radio noise emissionsfrom adigital apparatus

as set out in the interference- causing equipment standard entitled “Digital Apparatus,” |CES- 003 of
the Industry Canada

Cet appareil numérique respecte leslimites de bruits radioé ectriques applicables aux appareils
numériques de Classe B prescrites dansla norme sur le matériel brouilleur NMB- 003 d'Industrie Canada
intitulée « Appareils numériques ».

I | ntcnational Enercy STAR® Program

Asan ENERGY STAR Partner, Canon Inc. has determined that this product meets the ENERGY STAR
guidelines for efficiency.

The International ENERGY STAR Office Equipment Program is aglobal program that
/_\ promotes energy saving through the use of computer and other office equipment. The
W program backs the development and dissemination of products with functions that
——  ¢ffectively reduce energy consumption. It is an open system in which business can

participate voluntarily. The targeted products are office equipment such as computers,

monitors, printers, faxes and copiers.

Their standards and logos are uniform among participating nations.

I oo Requirements

Never use a power supply voltage other than that supplied in the country of purchase. Using the
incorrect voltage could cause afire or electric shock. The correct power supply voltages and frequencies
are asfollows:

Europe AC 230V+10%, 50Hz
USA/Canada  AC 120V, 60Hz
Australia AC 240V, 50Hz

Printer Model: K10219 (i850)



Preface

Shipping Materials

Thank you for purchasing a Canon Bubble Jet Printer.
Check that al the following items are in the box. If anything is missing or is damaged, contact your Canon
Authorised Dealer or Sales Representétive.

U Printer

U Setup Software & User’s Guide CD-ROM
4 Quick Start Guide

O Print Head

4 4 Ink Tanks

* Cables should be purchased separately according to your computer. For details on cable types and
specifications, refer to page 2.

Introduction

This Quick Start Guide uses the following symbols to indicate important information. Always observe the
instructionsindicated by these symbols.

Instructionsthat, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Also read the Safety Precautionsin the User’s Guide. Observe the warnings and cautions to avoid
personal injury or damage to the printer.

/Trad emark Notices

« Canon® isaregistered trademark of Canon Inc.

* BJ™ jsatrademark of Canon Inc.

+ Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
U.S. and other countries.

» Apple, Mac and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other
countries.

 All other trademarks and registered trademarks appearing in this Quick Start Guide are the property of
their respective owners.

Copyright ©2002 CANON INC.
All rights reserved. No part of this publication may be transmitted or copied in any form whatsoever
without the express written permission.




Setting Up

1 Preparing the Printer
1 Place the printer on a flat surface.

2 Remove the packing material and tape
from the printer as shown.

2 Connecting the Printer to the Computer

Use either aUSB cable or pardle printer cable. You cannot connect the computer to the printer using both
the parallel cable AND the USB cable.

USB cable Printer cable (parallel)
» Windows XP, Windows Me, » Windows NT 4.0, Windows 95
Windows 2000, Windows 98, (Can also be used with Windows XP,
* Mac OS 8.6 or later Windows Me, Windows 2000 and
Windows 98.)

Recommended: Canon or other computer Should conform with Centronics | EEE 1284

manufacturer cable, up to 5 metersin length. and support bi-directional communication.
Recommended: Canon or other computer
manufacturer cable, up to 2 metersin length.

= Notes

» The USB cable deliversrelatively faster printing speeds and is recommended for use with
Windows XP, Windows Me, Windows 2000 and Windows 98.

* |f your computer has an earth connection, make sure that thisis attached.

« If you do not intend to use the printer for along period of time, unplug the power cord from the
power outlet after turning off the printer.




Follow the steps below to install the printer driver
correctly.

1 Ensure the printer and the computer are
switched off.
Figure A 2 Connect the cable.

Figure A shows the USB cable connection and Figure B
shows the printer cable (parallel) connection.

= Note

If the Add New Hardware Wizard or Found New Hardware Wizard
screen appears when carrying out the following operations, click
Cancel and turn off the computer.




3 Installing the Print Head

» Never attempt to plug the power cord into the power outlet or unplug the power cord when your
hands are wet.

» Never damage, modify, stretch, or excessively bend or twist the power cord. Do not place heavy
objects on the power cord.

» Never use any power supply other than the standard power supply available in the country of
purchase. Using the incorrect voltage and frequency could cause afire or electric shock.

« Always push the plug all the way into the power outlet.

B Installing the Print Head
1 Plug the printer in.

2 Turn on the printer. Do NOT turn on the
computer yet.

The POWER lamp flashes and the printer beginsto
operate. Wait until the POWER lamp remains fully lit.

3 Open the front cover.

4 Remove the tape.

5 Raise the lock lever.

Do not touch internal parts other than the lock lever.




6 Remove the protective cap from the
print head.

= Notes print head nozzles

Do not touch the print
head nozzles or electrical [
electrical contacts. contacts |

* Do not attempt to
reattach the protective
cap onceit has been
removed.

7 Place the print head in the holder.

= Notes
Be careful not to touch any parts inside the printer.

8 Lock the print head into place by
lowering the lever.

Do not touch the lock lever once the print head has been
installed.

B Installing the Ink Tanks

* For safety reasons, store ink tanks out of the reach of small children.
» Do not drop or shake ink tanks.

1 Take out the yellow ink tank.

2 Pull the orange tape in the direction of
the arrow and remove the clear film.




Protective cap 3 Hold the ink tank as shown in the
diagram and remove the protective cap.

= Notes ink port

* Do not squeeze the sides of %
theink tanks as this may
cause theink to lesk out and 0@ &)
stain your clothes and hands.

* Do not touch the ink port.

* Do not attempt to reattach the
protective cap once it has
been removed.

4 Insert the yellow ink tank into the right-
hand slot. Press the top until it clicks
into place.

5 Use the same procedure to install the
other ink tanks in their appropriate slots.

Check the labelsto make sure that each tank isin the
correct position.

= Notes

» Only install theink tanksin the positions specified
by the labels.

* If ink tanks are not installed in the right position,
colorswill not be printed correctly. Immediately
reinstall the tank in the correct position and carry

Black Cyan Magenta Yellow out print head cleani ng. For details, refer to the

User's Guide.

6 Close the front cover.

Wait until the POWER lamp remains fully lit (about 60
seconds).



4 Loading Paper

B Loading A4 (Letter) Size Plain Paper
paper thickness lever 1 Open the front cover.

Move the paper thickness lever at the
top of the print head holder to the left
position. Close the front cover.

= Note

Set the paper thickness lever to the left when using
plain paper, to the right when using thick paper.
Refer to the User’s Guide for information on loading
envelopes and other media.

Pull out the paper rest and the output
tray as shown.

output tray \

print side 4 Load the paper, aligning it with the right
side of the sheet feeder.

You can load up to 150 sheets of plain paper. Do not
exceed thislimit.

5 Press the paper guide and slide it
against the left side of the stack of
paper.

You now need to install the printer driver:
Windows: Go to page 8
Macintosh: Go to page 10




5 Installing the Printer Driver

B Installing the Printer Driver — Windows

= Notes

« Do not disconnect the cable or remove the CD-ROM during the installation. The driver cannot be
correctly installed.

» The screens below refer to Windows X P installation. Screen may differ depending on the operating
system you are using.

* When installing the printer driver in Windows X P, Windows 2000 or Windows NT 4.0, log on to
the system as a member of the Administrator s group.

If the following screen appears automatically, click Cancel and follow steps 1 to 8 to ingtall the driver.

Welcome to the Found New The wizard could not find the software on your computer for. 55
Hardware Wizard

This wizard helps you nstal software for

(), 1 your hardware came with an nstallaion €D
&2 or floppy disk. insert it now.

i soltas o e it

1 you know another plsce where the softwate might be located, cick Back and select
oplion

Specia Notes for Windows Me or Windows 98 USB Users
Click Cancel to quit the screen and turn off the printer. Next, remove and replace the USB cable
connected to your computer.

1 Ensure the printer and computer are
switched off.

2 Turn on the computer and start
Windows. If any applications
automatically run, quit them.

Disable any virus detection programs.
Do NOT turn the printer on at this stage.




Canon Pt D
| Readme )
| About
Printer Driver |
Documentation |
Ckth ot st
= I Install J I s )

Follow tis prosedue.
1.Check that the cable is connected.

2.Tum the printer on.
3 Piinter port will be detected. Please wait.

i D This display wil go
mpleted.

select the port or comnect with nfiared
. cick Manual selection.

Printer Driver Installed

3 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

= Notes

« If the CD-ROM does not run automatically, click
Start and My Computer, then double-click the
CD-ROM icon. For non-XP Windows, double-
click My Computer in the Windows screen, then
double-click the CD-ROM icon.

« If the language sel ection screen appears, select a
language, then click the OK button.

4 Follow the instructions displayed on
screen. When the screen shown on the
left is displayed, click Install.

5 When the screen shown on the left
appears, turn the printer on.

If the printer is recognized, the printer driver will be
automatically installed.

= Note

If the connection is not recognized, refer to the
section “Notes on Handling the USB Interface (for
Windows Users)” on page 21.

6 Click OK.

Before you can use the printer, you must carry out print
head alignment on page 12.



o [— 7 When the screen shown on the left
appears, click Exit.

Printer Driver

= Notes

* To view the User’'s Guide, please refer to page 21.
« If amessage prompting you to restart the
computer appears, click Yes.

Documentation

B Installing the Printer Driver — Macintosh

= Notes

< Do not remove or insert the USB cable during installation, as this may result in the computer or
printer not operating correctly.

» Beforeinstalling the driver, disable al virus detection programs and automatically loading
programs or remove them from your system folder.

1 Turn on the Mac.

2 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

Double-click the Mac OS 8.6-9.x folder.

(3 Canon_BJ
3 items, 1.72 GB available

m
W

Mac0S B.6-9.2  Mac 05X Manusl

S EID

KD

O =] Macosss-%=E1 B
1item, 1.72 GB available|

KD

4 Double-click the PrinterDriver folder,
then select a language.

S

0 —=———[ ANON.B —=0& 5 Double-click Installer.

3] Zitems, 1 ME available

Instal ler Read Mg
6 Read the Licence Agreement and click

o ST T e DR P e T Accept to continue.

R FOR BUSELE-JET PRINTER,

S ]

[4]¥

o icense agreement
INSTALLING THE PRINTER DRIVER FOR BUBBLE-
REE T0 BE BOUND BY THE TERMS OF

10



Installer EE]|

Easy Install E

dlick “Install"to install the following software: After the installation is
completed, restart the computer.

+i850 QuickDraw printer driver

+i850 printer utilities

+i850 printer profile

Wioation —
m Hers will be installed on the disk “UK H'

Install

Installation was successful. You have installed
software which requires you to restart your
computer. Ifyou are finished, click Restart, or if you
wish to perform additional installations, click

Continue.
(Continue ((Crestare J)

_[I3 rile Edit View Special Help

About This Computer
&0 Apple System Profiler

i, Favorites 4
Key Caps

Network Browser

[ RecentApplications »
[l Recent Documents  »

m

|=) Chooser

Connected to :
@ 850 1

%@

i
<

DT

FETTs

® Active
Qlnactive 745

AppleTalk

7 Click Install.
Wait for theinstallation to finish.

= Note

No other applications can be running during

@ this installation. Click Continue to
automatically quit all other running
applications. Click Cancel to leave your
disks untouched.

(cancer ] [Contue ]

If the above message appears, check that there are
no unsaved documents, then click the Continue
button. If a document needs to be saved, click
Cancel then save the document. After saving the
document, begin again from Step 4.

8 Click Restart.

The computer restarts.

9 Select Chooser in the Apple Menu.

10 Click the icon for the printer you are
using and close Chooser.

Before you use the printer, you must carry out print head
alignment on page 14.

= Note

Refer to the User’s Guide when using this printer as
anetwork printer.

11



6 Aligning the Print Head

This operation must be carried out when using the printer for the first time. Aligning the print head positions
allows you to print without shiftsin the color registration.

B Aligning the Print Head — Windows

*% Printers and Faxes

Canon iB50

7 This printer requires print head lignment.
Click Print Head Alignmert on the Maintenance tab bo start alignmert.

& Canon iB50 Printing Preferences

© Mon| © Poge Setup|| @) Stanp/Backpound | o Erfects | (3 Profes
Sowrs Pyt
i B B p=
i oedsin o ok = E5s
2 L<
Cmenires Qo
D5 Ston Staus Morior.
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1

Click Start and select Control Panel,
Printers and Other Hardware, and
then Printers and Faxes.

= Note

For non-XP Windows, click Sart, then select
Settings, Printers.

Click the icon for your printer.
Open the File menu and select:

* Windows XP/Windows 2000 —[Printing
Preferences...]

* Windows Me/Windows 98/Windows 95 —
[Properties)]

* Windows NT 4.0 -[Document Defaullts...]

to open the setting screen.

Click OK.

Click the Maintenance tab, and click
the Print Head Alignment icon.

Check that paper is loaded in the printer
and click OK. If a message warning you
not to perform other operations
appears, click OK.



A 7 After the pattern is printed, click Yes.

9 ) Didthe pattern prink successfully?
</

IF nothing was p

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly
installed.

8 Look at the print-out. From the patterns
in Column A, select the most even, least
irregular pattern and enter the number.

=

F T 2I0)

EIx 9 In the same way, one by one, select the
most even patterns printed with the
least irregularities from each of
Columns B to K, enter their numbers,
and click OK.

If itisdifficult to pick the best pattern on Column F, pick
the setting that produces the least noticeable vertical

Fiint head afgnment s being exected. Refering 1o the palterns
w6k,

Horizontal Algnment (310 +7)

white stripes.
Less noticeable More noticeable
white stripes white stripes

10 Click Cancel.

This completesthe printer setup. The printer is now

ready to use.

= Notes

Click OK to perform even more detailed
adjustments.
If streaks appear on the printed surface when you
- use the printer, follow the procedure below to adjust
the printing.
N (1) Check that the paper that you normally useis
: set in the printer, and then click OK.
(2) Select the best patternsfrom ColumnsL and M,
enter their numbers, then click OK.
The best patterns will be smooth and have no
streaks in the border indicated by the arrows.

Jal

13



B Aligning the Print Head — Macintosh

Version 4.1

s
Q Deep Cleaning
Starts print-head deep cleaning.

Print head alignment is being executed.
Alignment entails printing, 5o do the
following: Ready the printer (connect the
cable and turn the power on), move the
printer’s paper thickness lever to the left,
and load a sheet of plain paper in the sheet
feeder

=

Print Head Alignment

Printhead alignment is being excuted. Referring to printed patterns
Ato F, select the pattern that shows no flaws.

Adjust sideways (-3
= ColumnA:
= ColumnB |
E ColumnC:
lgl ColumnD:
ColumnE:
Adjust both ways (-5~+5)
ColumnF:
Column 6:
ColumnH:
Column I:

Column J: B
ColumnK: o [l

C=0

14

1 Select Page Setup in the File menu.
2 Click Utilities.

3 Select Test Print from the menu and
click the Print Head Alignment icon.

4 Check that paper is loaded in the printer
and click OK.

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly
installed.

5 Look at the print-out. From the patterns
in Column A, select the most even, least
irregular pattern and enter the number.



Print Head Alignment

Print head alignment is being excuted. Referring to printed patterns

Ato F,select the pattern that shows no flaws.

Adjust VS (-3~+7)
ColumnA:

Column B :
Column C:
Column D :

ColumnE:

Column F :
Column 6 :

Column H:

Column 12

Column J :

Column K :

Basic print head alignment is complete. You
can printnormally.
To finish the alignment, click [Cancel].

If streaks appear on the printing side, you
can prevent them from appearing by
aligning the print head. If streaks appear on
the printing side, you can prevent them
from appearing by aligning the print head.
To proceed to this alignment, insert a sheet
of paper into the sheet feeder and click
[OK].

T ()

= ()

Canon 850 Printer Utility Version 4.

6 Inthe same way, one by one, select the

most even patterns printed with the
least irregularities from each of
Columns B to K, enter their numbers
and click Send.

If itisdifficult to pick the best pattern on Column F, pick
the setting that produces the |east noticeable vertical

white stripes.
More noticeable

Less noticeable
white stripes white stripes

Click Cancel.

This completes the printer setup. The printer is now

ready to use.

= Notes

Click OK to perform even more detailed

adjustments.

If streaks appear on the printed surface when you

use the printer, follow the procedure below to adjust

the printing.

(1) Check that the paper that you normally useis
set in the printer, and then click OK.

(2) Select the best patternsfrom ColumnsL and M,
enter their numbers, then click Send.
The best patterns will be smooth and have no
streaks in the border indicated by the arrows.

8 Click Close.

15



Basic Operations

« |If you detect smoke, unusual smells or strange noises around the printer, immediately switch the
printer off and aways unplug the printer. Contact your local Canon service representative.
» Toavoid injury, never put your hand or fingersinside the printer whileit is printing.

Printing with Windows

Adjusting the print settings according to your needs allows you to produce better quality prints.
In this section, we will use WordPad for the purpose of explanation. The procedures you use and the screens
that appear on your computer may differ according to the application that you use.

B Printing
. T 1 Print the document from the application.
ey con ] On the File menu, click Print.
e ams o [0 Check the application’s users manual for the actual
Save fs... P procedures.
R
Prink Presview
o Bl 2 Ensure your printer is selected, then
L click:
» Windows XP —[Preferences]
» Windows Me/Windows 98/Windows NT 4.0/
o Windows 95 —[Properties]
—— * Windows 2000 —[Main] tab
3 Specify the required settings and click
OK.
= Note
If you use anything other than plain paper, please
refer to “Basic Print Settings’ on page 17.

4 To start printing, click Print.

Printing will start in afew moments.

16



B Basic Print Settings

For the best print quality, specify the minimum requirement settingsin the Main tab. To get the best
results, ensure you select the type of medialoaded in the printer when printing on paper other than plain

paper.

&) Main | £ Page Setup | @ Stamp/Background | o# Effects | (5 Profiles | fi§ Maintenance

2 printing Preferences (| ] | (6)

Media Type ( Plain Paper 1)
Papes Sounce: T v
Print Quality: O High
(© Standard @)
O Dyatt
() Custom

Color Adjustment: (& Auta (3)
O Manual

Color Printin
W [] Grawssale Printing
(O Provieuw betors pnnungj\ @)

| T el O

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Quality

Select one option from High, Standard and Draft. Select Custom to
set the print quality manually.

(3) Color Adjustment

If you wish to control the color adjustment settings in more detalil,
select Manual.

(4) Preview before
Printing

Select this to check the layout before printing.

(5) Help Click this for a more detailed explanation of the functions in the tab.
(This may not appear when using Windows 2000 or Windows NT 4.0.
If this happens, click Start then select Programs - Canon i850 -
Guide).
(6)? Click this to change the cursor shape to ?. By clicking on the item’s
name with this ? cursor, an explanation will be displayed.
= Notes

« Clicking the Print Advisor allows you to change to the most appropriate print settings simply by
answering questions when prompted.

» Use the application to set the paper size and paper orientation. Before printing, open the settings
screen and check that the Page Size in the Page Setup tab is the same as that specified within

application.

* Refer to the User’s Guide for more information about printer driver functionality.

17



Printing with Macintosh

Adjusting the print settings according to your needs allows you to produce better quality prints.

B Printing

@ Edit Font Size Style So
| New BN PV——rZ "—H—
Open.. 380
Close W
Save 1
Save As...

Page Setup... |

Print... P
Print One Copy

Quit %0Q

canonisso

scate: [100])

orentation:
[ Save Settings
@ Edit Font Size Style 5o
O New BN e—
Open... 30
Close EW
Save #S
Save As...
Page Setup...
Print One Copy
Quit 380

Canon i850 Version 4.1

T comies: [1]
J Pages: @ All
Grom [0 [
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1 Open the Page Setup dialog box in
your application.

On the File menu, click Page Setup. Check the
application’s users manual for the actual procedures.

2 Specify the page setup.

For details, refer to “Page Setup” on page 19.

3 Open the Print dialog box in your

application to print the document.

On the File menu, click Print. Check the application’'s
users manual for the actual procedures.

4 Specify the print settings according to

your requirements.

For details, refer to “Basic Print Settings’ on page 19.

5 Click the Print button.

Printing will start in afew moments.



B Page Setup

Use the Page Setup diaog box to specify the paper size settings.

Canon 850 Version 4.1
oK
Paper size|; [A4 :]) ] Select paper

[ Banner POV size you

[ Borderless Printing .

Amount of Extension : wish to use.

Min, Max,
Scale : %

[ L LR T RN

[ save Settings

B Basic Print Settings

For the best print quality, specify the minimum requirement settingsin the Print dialog box. To get the
best results, ensure you select the type of medialoaded in the printer when printing on paper other than

plain paper.
Canon is50 Ver: m
' () @
Copies:
o Cancel
Pages: @ All
gmem [ |10 [ ]
ST BJ Cartridge :
y [Calor Al
Z aperSource
" Auto Feeder *
Normal-size printing Print Mode : — (2)
(Text |
I Grayscale Printing

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Mode

Select the type of document you want to print.
To specify more detailed settings for the print quality or color, select
Manual and click Details.

(3) Print

Click this to start printing.

= Notes

* See Balloon Help for more information about other printer driver functions.
Select Show Balloonsin the Help menu for an explanation of each of the items in the setting
screen. To see the explanation, point to the item with the mouse.

* Refer to the User’s Guide for more information about printer driver functionality.

19



Print Head Maintenance

B If Blurring Occurs or If a Specific Color Does Not Print

Perform print head cleaning to improve the print quality. Ensure that the printer is turned on and follow
the instructions bel ow.

* Windows
Open the printer driver settings screen and click the M aintenance tab. Click the Cleaning icon.
See page 12 for details on how to open the setting screen.

* Macintosh
Open the Page Setup dialog box and click the Utilities button. Click the Cleaning icon.

B When the Printer Runs out of Ink

Replace the empty ink tank with anew one.
Specify the following ink tanks when purchasing.

Yellow BCI-3eY
Magenta BCI-3eM
Cyan BCI-3eC
Black  BCI-3eBK

1 Open the front cover and remove the
empty ink tank.

Do not touch the lock lever.

lock lever

2 Install the new ink tank.

Close the front cover when finished.

= Note

For more detail s about maintenance, refer to the
User’s Guide.




Notes on Handling the USB Interface (for Windows Users)

If installation of the printer driver does not proceed as instructed in this Quick Start Guide, there may be a
problem with the USB driver instalation.
Try reinstalling the printer driver.

B Reinstalling

If you cannot proceed beyond the Printer Port screen:
Click Cancel.

When the Terminate Installation
screen is displayed, click OK.

Click Exit, then remove the CD-
ROM.Turn the printer off.

Turn the printer off.

Restart the computer.

S O W Nk

Reinstall the printer driver (see page 8).

For Further Details...
For more information, place the Setup Software & User’s Guide CD-ROM in the CD-ROM drive.

B User’s Guide Contents

The“User’'s Guide” isin PDF format and can be found on the same CD-ROM asthe printer driver. You
can view this Guide on screen and print out any sections you require.

Contents

* Printer parts and their functions  Printing media
* Printer driver functions  Troubleshooting
« Routine maintenance » Specifications

B How to View the User’s Guide

For Windows For Macintosh
(1) Load the CD-ROM inyour computer. (1) Load the CD-ROM in your computer.

(2) Click Documentation on theleft of the screen. If Acrobat Reader 3.0 or later is not already
(3) Click View Documents. installed, double-click the Acrobat Reader 4.0
If Acrobat Reader isnot installed or Acrobat folder in the CD-ROM folder, then double-

Reader 4.0 isinstalled, amessage appears. click Reader 4.0 Installer. Follow the
Click Yes. Follow the instructions on screen to instructions on the screen to install Acrobat
ingtall the program. The User’s Guide will Reader.

appear onceingallation is complete. (2) Double-click the Manual folder.

(3) Select alanguagefolder.
(4) Double-click theicon for the
i850_UG_UK.PDF file.

21
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BJ Printer Driver Systems Requirements

For Windows

» Use acomputer on which Windows X P, Windows 2000, Windows Me, Windows 98, Windows
NT 4.0 or Windows 95 can operate.

» USB* interface or standard 25 pin parallel interface

* Available hard-disk space for printer driver installation

Windows X P/Windows 2000/Windows NT 4.0: 50MB
Windows Me/Windows 98/Windows 95; 15MB

* USB operation can only be guaranteed on a PC with pre-installed Windows X P, Windows
2000, Windows Me, or Windows 98. (Thisincludes Windows X P, Windows 2000 or Windows
Me upgraded from pre-installed Windows 98 or |ater)

For Macintosh

» Use aMacintosh series computer equipped with USB interface on which Mac OS 8.6-9.x can
operate.

+ 30MB of available hard-disk space for printer driver installation

Additional Systems Requirementsfor User’s Guide

« Pentium® 75 MHz equivalent or higher processor (Pentium® 133MHz equivalent or higher
processor recommended)

e 2x or higher CD-ROM drive (4x or higher recommended)

* 10 MB of available hard-disk space (when installing the User’s Guide)

« Microsoft Internet Explorer 5.0 or later
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